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Bem-vindo à quarta edição do The Widget. Não é maior (porque não queremos que seja maior!), mas esperamos que seja melhor, contendo apenas as principais informações necessárias para que seu projeto seja um sucesso até o dia do arquivamento.
A grande diferença é que, para este Widget, estamos praticando o que estamos pregando. Criamos esse widget na plataforma Workiva e o exportamos para o software Adobe InDesign. Nosso formato é paisagem (muito melhor para telas). E também criamos o XHTML - a viagem completa de ida e volta.
Reserve um tempo para dar uma olhada no Core Essentials. As informações aqui são muito importantes em sua jornada na Workiva e realmente economizarão seu tempo quando você iniciar seu projeto.Para relatórios que precisam aderir ao Formato Eletrônico Único Europeu (ESEF), as dicas são mostradas aqui.
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Todas as informações, conteúdo e materiais disponíveis neste documento são apenas para fins de informação geral. O conteúdo desta postagem é fornecido "no estado em que se encontra"; não é feita nenhuma declaração de que o conteúdo esteja livre de erros ou atualizado. Os designers devem testar seu design em XHTML com frequência e manter arquivos de backup o tempo todo.


A Workiva é para todos!
· Estar em casa com o software InDesign ou ficar em casa na plataforma Workiva
· Compatibilidade de formato
· Controle fácil de alterações e versões
· Veja seu design em XHTML sempre que quiser
· Sem tempo de inatividade para todos os usuários e designers
As principais conclusões são: teste seu design antecipadamente e com frequência em XHTML e certifique-se de que você está confortável com o processo. A seção Core Essentials é essencial para uma integração bem-sucedida.











Nossos workshopsPrincipais recursos

Introdução a todo o processo
Este workshop analisa todo o processo de exportação de conteúdo da plataforma Workiva para o software InDesign, juntamente com a inclusão da marcação XBRL™. O mandato usado neste webinar é o mandato da ESEF, no qual as tags iXBRL™ são adicionadas às principais demonstrações financeiras, mas ainda é relevante para os clientes que usam outras taxonomias.
· Demonstração da integração entre o software InDesign e a plataforma Workiva
· Visão geral dos recursos e da funcionalidade
Considerações de design para a Web
Esta sessão divertida analisa como o design de impressão precisa se adaptar à visualização on-line.
· É a morte da propagação?
· Existe uma função para o divisor?
· Tipografia para publicação multicanal
· A XBRL afeta o design?
· Projetando para XHTML
Guia básico para designers iniciantes na Workiva
Este workshop é um pouco mais lento para designers iniciantes na publicação multicanal.
· As oito etapas necessárias para obter relatórios multicanais sem problemas

Fluxo de trabalho avançado
Esta sessão trata da preparação para o arquivamento, com ótimas dicas. Por exemplo, o que fazer com as imagens ao manter uma versão para impressão e para a Web.
· Edição de última hora
· Métodos de imagem complexos
· Mudança rápida dos modos de impressão para a Web no software InDesign
Tudo sobre tipografia
A tipografia é discutida neste workshop, de modo que assuntos como gerenciamento de widow, licenciamento de fontes e texto justificado ao publicar na Web.
· Fluxo de trabalho
· Design
· Técnica
Como ter um ótimo envio
Embora esse workshop prepare um arquivo para os critérios do mandato da ESEF, ele é relevante para todos os designers, pois aborda o gerenciamento de cabeçalhos e rodapés, o teste de seu arquivo IDML e os cenários em que você pode precisar adicionar conteúdo extra que não está na plataforma Workiva
· Revisão da XBRL
· Revisão do formato do relatório
· No dia do registro
Veja nossos workshops aqui











Melhorar constantemente a produtividade em vários canais para ajudar na criatividade. Aqui estão listadas as atualizações da versão 3 do Widget.O quehá de novo

Palete de estilo atualizado
Agora há uma barra de pesquisa no menu suspenso Styles (Estilos). Comece a digitar e todos os estilos relevantes serão exibidos. Isso torna a localização de estilos muito mais rápida. Lembre-se de que você pode ordenar seus estilos na guia Edit Style Guides (Editar guias de estilo).
Graças a essa atualização, os designers agora podem organizar seus estilos alfa numericamente com base na relevância e no uso.
Gerenciamento de estilo atualizado
Os estilos automatizados agora são baseados no estilo personalizado do qual vieram originalmente. Você pode controlar aspectos dos estilos propagados editando o estilo de rota nas paletas de caracteres e de parágrafos.
Lista com marcadores
No momento, as listas com marcadores são substituições e criarão um estilo gerado automaticamente. A prática recomendada é criar um estilo dedicado para listas com marcadores e enumeradas e aplicar os marcadores como uma substituição da maneira normal.
Quando você exportar para o software InDesign, os estilos de lista com marcadores aparecerão juntos em suas paletas de estilos com alguns números aleatórios depois deles. Isso ocorre porque o estilo é gerado automaticamente. Você pode localizar e alterar rapidamente seus atributos. Apenas para observar, não altere os nomes dos estilos.
Wingdings e dingbats
Se estiver usando wingdings e dingbats, teste-os durante todo o processo para ter certeza de que estão sendo renderizados conforme o esperado.
Relatório de discrepância
Esse relatório ajuda a mostrar quaisquer problemas na conversão de IDML para XHTML na plataforma Workiva. Seu objetivo é alertar os designers sobre itens que não são compatíveis com o

Processo de conversão IDML>XHTML. A maioria dos avisos tem a ver com XHTML, mas alguns são para preservar a integridade do XBRL. Por exemplo, coisas como imagens vinculadas sinalizarão avisos. O relatório é criado quando você converte seu arquivo em XHTML e fica ao lado do arquivo XHTML, pronto para ser visualizado. Esse relatório não coleta tudo, portanto, essas diretrizes ainda devem ser seguidas à risca.
Pacote inicial de relatórios anuais do ESEF
Este pacote contém
· Lista de verificação do mandato do ESEF
· Lista de verificação de envio do ESEF
· Lista de verificação da agência de design
· Navegação completa para arquivos de ajuda
· Modelo de relatório anual com 60 estilos predefinidos para uso na plataforma Workiva e no software InDesign
Encontre isso em marketplace.workiva.com
Plug-in
O novo plug-in de integração Workiva para o software InDesign foi fornecido para que os designers tenham agora uma ferramenta de validação que identifica problemas em um documento do software InDesign que poderiam corromper ou não ser apropriados para conversão em XHTML. Esse plug-in é fácil de importar nas versões para Mac e PC
do InDesign e grava um relatório com o clique de um botão. Veja o recurso Plugin aqui
Você já pensou em fazer uma parceria conosco?
Criamos um programa de parceria especialmente para equipes de design. Há muitos benefícios, incluindo certificação, acesso ao seu próprio espaço de trabalho na Workiva e oportunidades de marketing conjunto.
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Para que a plataforma Workiva interaja bem com o software InDesign, você precisa configurar seu relatório corretamente. Dedicar tempo agora realmente trará benefícios mais tarde no projeto.C O R E  O E S C E N T uIAL
Configuração doSment no Workiva

Definir o esboço do documento
O esboço do documento representa a estrutura dos ICMLs. Há um ICML para cada seção ou filho de seção.
Crie sua paleta de estilos
Todo o conteúdo da plataforma Workiva deve ter um estilo associado a ele. Para a exportação do ICML, o estilo padrão "Normal" será convertido para o estilo Bodytext. Consulte nossa próxima seção para  obterdetalhadas informaçõessobre o Guia de estilo.
Cabeçalhos e rodapés
Os cabeçalhos e rodapés podem ser gerados na plataforma Workiva, mas não são exportados via ICML para o software InDesign. A exportação só pode enviar conteúdo em
entre as linhas tracejadas cinza na parte superior e inferior de cada página do documento.
Composição tipográfica
A composição tipográfica é feita na plataforma Workiva, não no software InDesign. Na publicação multicanal, a prática recomendada é não usar um retorno suave. Um retorno suave é quando você pressiona Shift Enter. Isso cria uma quebra de linha em vez de uma quebra de parágrafo. Você pode ver as devoluções suaves e difíceis pressionando a opção Mostrar/ocultar caracteres não imprimíveis na faixa de opções Editar.
Se as palavras não precisarem ser quebradas, como, por exemplo, o nome de um diretor, use um espaço sem quebra entre elas. Vá para Insert>Symbol>Special Characters>Non-breaking Space. Há também um atalho de teclado.

Formatos
É importante, em um cenário de publicação multicanal, estabelecer o formato da página, as margens e as medidas da sarjeta desde o início. Um dos principais motivos para fazer isso é a limitação do ICML de ajustar as larguras de tabelas e colunas. Portanto, eles precisam ser os mesmos na plataforma Workiva e no software InDesign.


Pontos a considerar:
Paisagem versus retrato
Tradicionalmente, a maioria dos relatórios anuais usa uma apresentação em retrato, mas cada vez mais a paisagem está sendo usada para melhor consumo na tela.
Spreads
O conceito de spreads é limitado no atual leitor em linha iXBRL. Os designers precisam ter cuidado ao confiar em um spread para transmitir informações, pois ele será dividido em duas páginas consecutivas separadas. É possível, com a ajuda do desenvolvimento da Web, apresentar spreads no visualizador em linha. Portanto, fale com a sua equipe da Web se os spreads forem necessários como parte da experiência do visualizador em linha.
 Margens espelhadas
Em geral, no caso de um documento que vai ser impresso, a margem interna será mais larga do que a margem externa devido ao ato de costurar. Isso pode apresentar um problema de legibilidade quando apresentado digitalmente em PDF e XHTML. Considere o ajuste das margens para apresentação digital.












Estilos de célulaTC O RaE E SbS E N lTIeA L Ss

A plataforma Workiva não usa estilos de célula. As exportações de ICML e XHTML contêm um algoritmo que resume os parâmetros de design em estilos de célula para InDesign e CSS, respectivamente.
Herança
A exportação do ICML agora usa o conceito de herança ou "Baseado em" nos estilos de caractere e de parágrafo. Isso
é extremamente útil para que os designers possam controlar grandes quantidades de
estilos de forma eficiente. Principalmente os estilos gerados automaticamente.
Tipos de células em Workiva
Os designers novatos na plataforma Workiva precisam estar cientes de que as células estão ativas em termos de formatação de conteúdo. Por exemplo, as células podem ser nomeadas como contabilidade, texto ou número
com casas decimais atribuídas automaticamente.
Larguras de tabelas e colunas
Os projetistas precisam estar cientes de que as larguras de tabelas e colunas não podem ser alteradas em ICMLs vinculados. Eles precisam estar corretos na plataforma Workiva.

 Gerenciamento da altura da célula
Há uma diferença substancial entre a maneira como o software InDesign e o XHTML lidam com a altura da linha no primeiro item de uma célula da tabela.
As tabelas na plataforma Workiva devem ser
definido com a largura correta. Isso não pode ser alterado no software InDesign.

Todos os estilos de célula no software InDesign são gerados automaticamente. Eles são baseados no No-Rule, de modo que as alturas podem ser controladas a partir daqui, uma vez no software InDesign.

Para fazer ajustes de modo que o XHTML pareça correto, os designers devem considerar essas duas soluções alternativas.
1. Faça com que a altura da linha do estilo de parágrafo da tabela seja igual ao tamanho da fonte.
O avanço de linha afeta a altura da linha de forma diferente
em XHTML e no software InDesign, portanto, é uma boa ideia definir
a altura da linha deve ser a mesma que o tamanho da fonte para estilos usados em tabelas.

2. Ajuste o Padding Top e o Padding Bottom do estilo "No-Rule" nos estilos de célula.
Suportes coloridos
Você poderá ver colchetes coloridos ao redor dos valores financeiros quando colocar seus arquivos ICML. Esses são espaços reservados para a marcação XBRL e não prejudicam em nada seus recursos de design. Você pode simplesmente ignorá-los.
A marcação XBRL falhará se essas regiões observadas (colchetes[]) forem divididas.
Isso pode acontecer quando se usa o recurso de história dividida do software InDesign. Os designers precisam ter cuidado ao usar esse recurso.











[bookmark: _bookmark0]Guias de estiloSC O R EtESyS E NlTeI A L  Ssetup

Um guia de estilo é um conjunto de padrões para o design de um documento que garante a consistência da formatação em todo o documento e/ou em vários documentos.
Para facilitar a exportação para o software Adobe InDesign, é desejável que todo o conteúdo da plataforma Workiva tenha um estilo personalizado associado aplicado a ele.
Há duas maneiras de um designer fazer isso
1. Configurar os estilos na plataforma Workiva e exportar para o software InDesign via ICML
2. Criar os estilos no software InDesign e importar de volta para a plataforma Workiva por meio do documento/software Microsoft Word
Práticas recomendadas para criar e usar guias de estilo
Você precisa considerar estilos para todo o seu conteúdo. Ao escolher o nome de um estilo, é uma boa ideia escolher um nome que reflita o uso do estilo, por exemplo
CaptionSmallBlue ou TableTextBold. Isso ajudará todos na equipe a entender a estrutura e a aplicar o estilo correto ao conteúdo.
A eficiência da nomeação de estilos oferece estrutura e facilita a aplicação pelo usuário. Portanto, ao criar um estilo, pense em sua estrutura. Considere usar uma haste para indicar um grupo de estilos, por exemplo, corpo ou tabela, e depois indicar aspectos secundários, como texto, figuras, negrito.

	Caule
	Nível
	Natureza
	Modificação

	
	
	
	

	Tabela
	Texto
	Negrito
	Recuo

	Tabela
	Figos
	
	

	Legenda
	Pequeno
	Itálico
	Centro


Os nomes dos estilos podem conter letras e números, mas devem sempre começar com uma letra. Por exemplo, Heading1 é bom. 1Heading não funcionará. Isso tem a ver com a especificação de CSS (Cascading Style Sheets).

Caracteres como - !@#$%^&*()_+-={}:"<>?[];',./`~ etc. e espaços devem ser evitados.
Depois que os estilos são criados, eles podem ser bloqueados na plataforma Workiva para impedir que sejam alterados acidentalmente. No Style Guide Editor, a fonte, o tamanho da fonte, a cor da fonte, a ênfase, o alinhamento, o recuo e o espaçamento podem ser bloqueados independentemente.


[image: ]FAZER
Criar estilos no Workiva ou importá-los do InDesign
Crie estilos para o conteúdo da Workiva e para o conteúdo que não seja da Workiva (conteúdo externo), como legendas de imagens, cabeçalhos, guias de página etc.
Todos os nomes de estilo devem começar com uma letra, sem espaços e sem caracteres especiais (por exemplo, &#@)
Nomeie os subtítulos em ordem de tamanho da fonte para que todos possam entender Os recuos e os marcadores precisam ser definidos em um estilo
Adicionar um estilo personalizado a todo o conteúdo

[image: ]NÃO FAZER
Tente não usar substituições - crie um estilo separado
As guias não devem ser usadas - a Web não entende uma guia
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Os estilos do InDesign continuam sendo os principais
Você pode ajustar os estilos no software InDesign e eles permanecerão independentemente de outros ICMLs. O único estilo que deve ser o mesmo na plataforma Workiva e no InDesign é o Bodytext (escrito assim). Para melhorar a paridade, mantenha os atributos do Bodytext idênticos em ambas as plataformas.

O bodytext é um estilo especial e deve ser o mesmo tanto na plataforma Workiva quanto no software InDesign


Siga estas três etapas para garantir que tudo ocorra sem problemas.
 Primeira etapaImportação de estilos do InDesign
Se você tiver um documento existente do InDesign do qual precisa do conteúdo e do estilo, o procedimento a seguir é uma maneira útil de fazer isso com a vantagem adicional de que o conteúdo da plataforma Workiva pode ser exportado via ICML de volta para
esse documento do InDesign sem nenhum problema.
É uma prática recomendada não usar o estilo "Normal" na plataforma Workiva.
O software InDesign pode ter problemas com esse estilo padrão

Dê uma boa olhada nos seus estilos no software InDesign e certifique-se de que eles estejam em conformidade com os padrões de CSS da Web em termos de
nomenclatura (sem espaços, caracteres especiais etc.). Não use pastas de estilo.
 Segunda etapa
Copiar e colar conteúdo do software InDesign para o software MS Word. Os estilos serão copiados do InDesign. Fazer
certifique-se de que os estilos sejam aplicados ao conteúdo no Word, caso ainda não tenham sido aplicados automaticamente.

 Terceira etapa
Importe o documento do Word para a plataforma Workiva. Os estilos serão importados para a paleta de estilos personalizados.

Agora você precisa reaplicar os estilos a todo o conteúdo. (Estamos trabalhando para melhorar nosso procedimento de importação para que você não precise reaplicar estilos).

Agora você deve ter seu conteúdo na plataforma Workiva com os mesmos estilos do documento do InDesign. Podem ser necessários pequenos ajustes nos estilos personalizados da plataforma Workiva.




		

Reserve um tempo para configurar os estilos adequadamente
- realmente economiza tempo mais tarde


Transforme o padrão "Normal" em rosa para identificar o conteúdo perdido


Se a faixa de opções for clicada na plataforma Workiva, outro estilo será criado automaticamente












Para XHTML, somente cores RGB devem ser usadas, pois RGB é o único formato de cor compatível com a Web. O software InDesign usa CMYK e cores especiais Pantone para a impressão de tinta no papel. A Web não pode usar esses formatos de cores, pois o RGB é o espaço de cores padrão da Web. Se o software InDesign estiver sendo usado para criar e esse conteúdo for convertido em XHTML, deverão ser usadas cores RGB (vermelho, azul, verde).CC O R EoE S SlENoT I AuL S
r gerenciamento
Certifique-se de que haja contraste de cores suficiente para facilitar a leitura por todos os usuários.

A conversão de CMYK para RGB não é simples. Portanto, é melhor que os designers especifiquem RGB em seus documentos do InDesign para que a precisão seja mantida e não haja surpresas durante a conversão.Lembre-se das limitações da tela ao escolher cores para a Web.

Hexadecimal é outra forma de descrever  a corRGB na base 8 (hexadecimal). As cores Pantone (spot) são usadas na impressão. A tinta usada é a cor real especificada, em vez de ser composta de cores CMYK. Eles são
frequentemente especificados nas diretrizes de marca para uma cor corporativa devido à sua precisão. É aconselhável sempre verificar as diretrizes de marca para cores específicas em vez de confiar na conversão.

RGB





[image: ][image: ]CMYKTodas as cores precisam estar em RGB para uso na Web/ ESEF
RGB
CMYK
HEX
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LicenciamentoFC O R OE E SnS E NtT I AsL S

Para publicar em XHTML, as empresas precisam ter os direitos de uso na Web de qualquer peso de fonte que esteja sendo usado em seu arquivo iXBRL/XHTML.
No momento, um registro iXBRL constitui uso da web. Recomenda-se que as empresas verifiquem o status do licenciamento de todas as fontes que estão usando. Além disso, os emissores não podem contar com os fornecedores para fazer isso por eles ou, de fato, manter essa licença em nome do emissor. Além disso, o licenciamento é baseado no "peso" de cada fonte, portanto, se você estiver usando apenas dois pesos de uma família de fontes, só precisará estar em conformidade com esses pesos.
Se a fonte estiver disponível na plataforma Workiva, ela é de código aberto ou tem a licença apropriada. Aconselhamos que os designers verifiquem com seus clientes o uso de fontes se eles não estiverem na plataforma Workiva.
Fontes de código aberto
Pode valer a pena considerar as fontes do Google e outras fontes de uso gratuito, não apenas por motivos de custo, mas porque elas são especialmente adaptadas para a Web.
Fontes da Web (woff e woff2)
O Web Open Font Format é agora o padrão para o uso de fontes em navegadores e as fontes OTF e TTF serão convertidas para esses formatos no momento do upload ou os designers poderão fazer o upload das fontes nesses formatos. Os navegadores e as versões compatíveis estão abaixo. Está havendo uma discussão sobre o suporte a TTF para versões mais antigas desses navegadores.


Teste de renderização de fontes em navegadores
É importante que os designers testem a renderização de fontes nos navegadores para evitar efeitos inesperados. É fundamental que as escolhas de fontes sejam feitas com esse conhecimento. Além disso, alguns pesos de fonte em itálico e algumas fontes sem serifa mais antigas tendem a não ter uma boa aparência quando renderizadas nos navegadores. Recomendamos testar as fontes com antecedência.
Fontes que não estão na plataforma Workiva
Certifique-se de que as fontes usadas no software InDesign sejam carregadas com seu IDML no momento da conversão. Você precisará compactar o IDML e a pasta de fontes para a importação. Se as fontes estiverem disponíveis na plataforma Workiva, essa etapa não será necessária.Para o ESEF, as fontes usadas no formato iXBRL são convertidas para o formato base64 e incorporadas ao CSS











 Fontes personalizadas
Isso inclui fontes criadas por motivos de licenciamento ou uso decorativo no texto. Faça um teste completo com o processo de ida e volta para que você tenha certeza de que a construção da fonte é adequada para o processo de conversão da plataforma Workiva.
Renomeação de fontes
Lembre-se de que renomear fontes pode torná-las inoperantes ou fazer com que elas não apareçam. Oarquivo de registro da Workiva Integration Tool (plug-in) especifica os nomes familiares e postscript das fontes usadas em um documento.











Gerenciamento de viúvasTC O R yEE SpS E N oT I A LgS
 layout gráfico

Uma definição de gerenciamento de viúvas é garantir que a última linha de um parágrafo não seja uma palavra com uma única letra ou um número. Isso pode parecer feio e adicionar espaços em branco desnecessários em um design, além de tornar o conteúdo mais longo do que o necessário. Ao longo dos anos, os designers implementaram vários métodos no software InDesign para se livrarem das viúvas.

O método de retorno suave
Esse método agora é amplamente depreciado na publicação multicanal porque as larguras dos quadros de texto podem variar em layouts responsivos. Os retornos suaves podem ter consequências infelizes
em tais layouts. As diferenças de renderização do navegador também podem ter o mesmo efeito.
O método de kerning
A(s) linha(s) anterior(es) à viúva é(são) destacada(s) e o espaçamento entre caracteres (kerning) é reduzido, permitindo que a viúva suba para essa linha. Isso pode ser replicado em XHTML, mas pode causar problemas imprevistos na renderização desse conteúdo.
O método de condensação
Como acima, mas em vez de kerning, os caracteres são condensados em largura (por exemplo: 95%). Isso pode ser replicado em XHTML, mas pode causar problemas imprevistos na renderização desse conteúdo.
Método de composição do InDesign
O software InDesign tem um algoritmo que pode evitar as viúvas. Ele não é recomendado para uso em vários canais e não é implementado com frequência por designers.

Recomendação
Nosso método recomendado de gerenciamento de viúvas é o uso de nbsp. Isso pode ser feito facilmente na plataforma e é exportado via ICML e convertido via IDML em XHTML.

O método de espaço não quebrado (nbsp)
Amplamente considerado como a melhor maneira de controlar as viúvas na publicação multicanal. O intervalo entre as palavras é preenchido
com &nbsp; ou &#160; efetivamente transformando duas palavras em uma palavra. Isso é ignorado pelos mecanismos de pesquisa e não pode ser visto por leitores humanos. Isso também funciona em layouts responsivos, pois só entra em vigor quando a largura de um quadro de texto entra em conflito com esse conjunto de palavras, forçando tudo para a próxima linha e, portanto, impedindo uma viúva.
Eles também são usados para manter nomes, nomes de lugares, nomes de empresas e conjuntos de números juntos.


Uma observação sobre o design
À medida que entramos em um ambiente multicanal e o uso de nbsp é aceito como a única maneira de gerenciar widows, os designers precisam pensar em seus designs e permitir um pouco mais de espaço em branco em seus layouts. Para obter o melhor da publicação multicanal, pense primeiro em XHTML.
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Recuos suspensos
Os designers talvez precisem experimentar o tipo de marcadores que desejam usar nas listas com marcadores. Wingdings, Zapf Dingbats ou outros tipos de bibliotecas de fontes podem ser usados se houver um equivalente em Unicode. Eles precisam ser testados com antecedência para garantir que sejam traduzidos conforme o esperado.
Se os designers desejarem usar ícones ou imagens como marcadores, eles precisarão editar o CSS na pós-produção. Será necessário conhecimento especializado para isso, pois não é algo que a Workiva possa suportar.
Hiperlinks
Hiperlinks externos são suportados, mas hiperlinks externos não são permitidos de acordo com os requisitos do ESEF.

 Texto justificado
Embora não se trate estritamente de um problema de fonte, é muito importante observar que o XHTML é ruim na renderização de texto justificado em formato de várias colunas. O software InDesign tem ferramentas muito sofisticadas para justificativa que não podem ser replicadas em XHTML. Se possível, evite e use o intervalo à esquerda (chamado de ragged right em algumas jurisdições).
Grep
O Grep (impressão de expressão regular global) é muito usado por designers para controlar muitos aspectos do layout tipográfico. Há dois tipos de Grep no software InDesign.

Um bom exemplo do uso do Grep no software InDesign com conteúdo da Workiva é a alteração de traços em (EUA) para traços en (UE). Um estilo aninhado pode ser aplicado aos estilos de figuras de tabela para fazer essa alteração no conteúdo ICML. Esse Grep precisará ser aplicado com Localizar e Substituir quando os ICMLs forem desvinculados para tornar essa alteração permanente.
ListasProcurar em estilos
Isso às vezes é chamado de estilos aninhados. Essas são expressões regulares que correspondem a determinados padrões com base no conteúdo que é estilizado com um determinado
estilo. A plataforma Workiva não é compatível com o Grep em estilos.
Grep em Localizar e Substituir
Essas são expressões regulares usadas na função "Localizar e substituir" do software InDesign e só podem ser usadas em conteúdo não vinculado. Essas são alterações permanentes no conteúdo. Isso pode ser feito depois que os ICMLs forem desvinculados em preparação para o processo de conversão de IDML>XHTML.

Os estilos personalizados para listas agora podem ser criados na plataforma Workiva. Eles ainda são tratados como uma substituição, mas agora podem ser identificados no software InDesign como esse estilo de lista personalizado.
Para exportação de IDML, não divida um item com marcadores em quadros de texto. A lista pode estar em vários quadros, mas não em um marcador individual.




Nota aos designers - hiperlinks externos não são permitidos de acordo com o mandato do ESEF












Muitos relatórios também serão impressos, além de qualquer requisito de XHTML. Nesse caso, os designers precisarão manter dois conjuntos de ativos (imagens e gráficos) para diferentes canais de publicação.ICOmREE	 S aS E NgT I A LeS
especificações

Imprimir imagens
PSD e TIFF são formatos de imagem comuns para impressão, geralmente definidos em 300 dpi (pontos por polegada quadrada) e sempre CMYK. Gráficos sem resolução, como gráficos, são usados nos formatos Illustrator (AI) e EPS (Encapsulated Postscript).
 Formatos da Web
JPG, GIF, PNG (bitmaps) e SVG (sem resolução) são formatos comuns de imagens na Web. Os formatos de bitmap geralmente são definidos em 72 ou 96 dpi e são RGB.

	Imprimir
	Web (XHTML)

	.psd (cmyk, 300dpi)
	.png (rgb, 72dpi)

	.tiff (cmyk, 300dpi)
	.jpg (rgb, 72dpi)

	.jpg (cmyk, 300dpi)
	.jpg (rgb, 72dpi)

	.ai
	.svg

	.eps
	.svg



O software Adobe Illustrator é capaz de produzir os formatos AI, EPS e SVG. A maioria dos editores de imagem, como o Photoshop e o GIMP, pode produzir todos os formatos de bitmap.
A principal diferença no uso de imagens entre impressão e web é que as imagens da web são cortadas nas bordas do quadro, enquanto as imagens colocadas em
InDesign geralmente não são. Para um designer de DTP tradicional, isso representa um processo extra, enquanto para os web designers, esse é uma prática comum. Os designers precisam
para encontrar uma solução dupla que lhes seja adequada e preservar a qualidade apropriada para todos os canais.

Incorporação de imagens
Todas as imagens exportadas em IDML devem ser incorporadas ao software InDesign. Isso converte a imagem em código baseado em 64. É esse código que é reconvertido na imagem original. Não há manipulação de imagens.
Ativos de impressão e da Web
Para os designers que estão configurando um documento para os formatos iXBRL e PDF, há duas soluções para lidar com o gerenciamento de diferentes ativos de imagem.
Um - Use duas camadas - uma para a Web e outra para impressão
Dois - Use duas pastas e, quando chegar a hora de mudar de uma para outra, você poderá usar a ferramenta de troca integrada no software InDesign.
Cor
É recomendável que os designers trabalhem primeiro em RGB e convertam para CMYK em um momento apropriado, quando for necessário imprimir a arte.




Cuidado com os JPGs
Os JPGs (JPEG) podem apresentar alguns problemas, pois podem ser salvos/usados em CMYK e RGB. Além disso, as versões mais antigas do software Adobe Photoshop e de outros programas de edição de imagens apresentam diferenças ao "salvar" e "exportar" para o formato jpg.
Uma observação sobre spreads
Imagens grandes usadas em uma página (duas páginas) precisam ser separadas/divididas para uso em uma única página.
Imagens e tamanho do arquivo
As imagens devem ser cortadas de acordo com o tamanho do quadro, reduzidas a 72 dpi e ser RGB. Eles devem ser do tipo de arquivo
- png, jpg ou gif.

Infográficos
Na história recente do software InDesign, ele aumentou sua capacidade de criar infográficos mais complexos.
Incentivamos os designers a testar essas páginas em seus relatórios com nosso
Conversor IDML>XHTML. Se os resultados não forem satisfatórios porque há certos aspectos aos quais não damos suporte, é muito fácil converter esses gráficos em SVG. As etapas a serem seguidas são;
1. Copie o infográfico para um documento em branco do InDesign
2. Exportar o infográfico para EPS a partir do software InDesign
3. Abra o EPS com o software Adobe Illustrator
4. Salvar o arquivo do Illustrator em SVG
5. Coloque o SVG no software InDesign para substituir o infográfico
Você precisará fazer considerações sobre a incorporação dos glifos de qualquer fonte usada ou converter o texto em contornos.

Vários efeitos e imagens combinados como uma única imagem
No software InDesign, é possível criar imagens compostas muito complexas usando uma combinação de mapas de bits, gradientes e outros efeitos.
Eles não são facilmente convertidos.  É melhor pegar imagens compostas e exportá-las do software InDesign para criar uma única imagem, como JPG, PNG, e substituir a imagem composta no software InDesign por essa imagem.











[bookmark: _bookmark1][image: ] Plug-in de integração Workiva para o software InDesignWC O R E EoS S E NrT IkAL S
plug-in de integração iva

O objetivo desse plug-in é oferecer suporte à conversão do InDesign em XHTML.
O conteúdo inicial deve ser criado na plataforma Workiva e exportado como ICML e, em seguida, importado para o InDesign. O
O Workiva Integration Plugin for InDesign Software deve ser usado quando os designers estiverem preparando o trabalho artístico e antes de trazer o conteúdo de volta para a plataforma Workiva como um arquivo IDML.
O plug-in é fornecido para que os designers tenham uma ferramenta de validação que identifique problemas em um documento do InDesign que possam corromper ou
não são apropriados para conversão em XHTML. Esse plug-in é fácil de importar nas versões do InDesign para Mac e PC e grava um relatório em com o clique de um botão. Em todos os casos, os aspectos que destacamos são
XHTML condicional e não uma condição específica da plataforma Workiva.

O botão Parar/Iniciar
Se quiser monitorar o ICML, use os botões de início e parada. Você pode pressionar start quando o ICML for importado inicialmente ou pode esperar até o final do processo. Isso é opcional.

Importar ICML
Examina sua área de trabalho para encontrar o arquivo exportado da plataforma Workiva.

Exportar IDML
Exporta o IDML do arquivo do InDesign para a área de trabalho.

Desagrupamento
Todos os itens devem ser desagrupados. Isso ajuda a desagrupar todos os itens agrupados existentes no arquivo do InDesign em um clique.

Validar
Pressionar esse botão produz um arquivo de registro que mostra avisos baseados na conversão desse documento de IDML para XHTML. Esse arquivo de registro pode ser encontrado em na mesma pasta da exportação do IDML. Isso deve ser revisado antes de cada importação para a plataforma Workiva.

Lista de validação
A lista de validação permitirá que você saiba se algo precisa ser atualizado ou incluirá alguns itens informativos de práticas recomendadas.
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O ICML (InCopy Markup Language) é um formato oficial do software InDesign e é usado para importar e exportar conteúdo estruturado para o InDesign. É
um arquivo vinculado ao InDesign e, como tal, o conteúdo de um arquivo ICML não pode ser editado no software InDesign até que o usuário desfaça o vínculo. Essa é a base da garantia de dados que a Workiva oferece a seus clientes que usam o software InDesign com a plataforma Workiva.

 Melhores práticas de importação do ICML
Verificar se todo o conteúdo está estilizadoICOCREE	MS S E N T ILA L S

Antes de extrair seu ICML da plataforma Workiva, certifique-se de que todo o conteúdo tenha um estilo atribuído a ele. A configuração padrão na plataforma Workiva é "Normal" e esse estilo é convertido em Bodytext na exportação via ICML. Uma maneira fácil de identificar o "Normal" é mudar sua cor para uma cor contrastante para facilitar a identificação, por exemplo, rosa brilhante.
Importação antecipada
Recomendamos que a importação seja feita logo no início do processo de geração de relatórios. Os prazos subsequentes das extrações do ICML devem ser discutidos entre o projetista e o cliente.

Importar uma quantidade de ICMLs antes de alterar os atributos
Um ICML representa um item de esboço na plataforma Workiva e esse ICML importa apenas os estilos associados a esse esboço (seção).

Recomenda-se que os designers importem uma boa quantidade de ICMLs para o software InDesign antes de começarem a alterar os atributos de estilo. É uma boa ideia ver todos os estilos que estão sendo usados antes de fazer qualquer alteração.
 Exportação do ICML
Quando estiver pronto, clique em Arquivo>Salvar como>InDesign (.icml). Em seguida, você será solicitado a selecionar:
Todo o documento Seção atual Selecione as seções
Os ICMLs são exportados em uma estrutura de pastas que representa o esboço da plataforma Workiva para facilitar a identificação.
Colocar ICMLs
Em seu documento do InDesign, vá para File>Place e navegue até o arquivo ICML. Uma vez colocado, o ICML pode preencher um ou vários quadros de texto vinculados.
Manter os links
Para garantir a segurança dos dados e para que você não precise se preocupar com versões ou verificação de conteúdo, certifique-se de não quebrar os links de seus ICMLs.

Atualizar os links
Com o ICMLS subsequente, basta atualizar os links no painel Links e a nova cópia atualizada será transferida para o software InDesign. Todos os seus valores de design permanecerão no lugar.
Mudanças de estilo
As alterações nos atributos de estilo no software InDesign permanecerão mesmo após a importação de outros ICMLs, embora o estilo permaneça como antes na plataforma Workiva. Portanto, a alteração de um atributo de estilo na plataforma Workiva não atualizará o estilo correspondente no software InDesign.
 Marcos do ICML
Quando você tiver decidido com seu cliente as datas de importação do ICML para o software InDesign, é uma boa ideia criar um marco na plataforma Workiva. Isso significa que você pode rastrear as alterações de conteúdo entre os pulls subsequentes do ICML criando uma linha preta.
No final do projeto, recomendamos que você faça uma extração completa do ICML de todo o documento para ter certeza absoluta de que cada ICML é o atual.







Melhores práticas de exportação de IDMLICODREEMS S E N T ILA L S	
 Lista de verificação do IDML
1. Salve uma cópia de seu documento mestre primeiro e use essa cópia para preparar a exportação IDML
2. Desagrupar todos os itens agrupados do InDesign.
3. Desvincular todos os arquivos ICML. Isso pode ser feito no painel de links.
4. Divida todos os quadros de texto conectados usando o script de divisão de história na paleta de scripts do InDesign.
5. Remova todas as camadas ocultas ou camadas usadas para fins administrativos.
6. Todas as imagens devem ser colocadas em 72 ou 144 dpi, RGB e cortadas no quadro da imagem. Isso reduzirá drasticamente o tamanho do arquivo.
7. Use SVG somente para gráficos vetoriais sem resolução, não para arquivos .eps ou .ai.
8. Certifique-se de que não haja excesso de matéria.
9. Certifique-se de que as guias ou substituições não tenham sido usadas.
10. Ao fazer upload de IDML, é melhor criar um pacote do InDesign para que você possa fazer upload das fontes também. Não é necessário carregar o arquivo .INDD. Você só precisa do arquivo IDML e das fontes em um único arquivo zip.

Exportação antecipada e frequente
Recomendamos que você exporte seu pacote IDML no início do processo de geração de relatórios e que faça isso com frequência. Recomendamos esse produto porque:
· Você se familiariza com o processo para evitar estresse mais tarde, próximo ao arquivamento
· Você pode verificar seu design abrindo-o no navegador - ele tem a aparência desejada?
· Você pode verificar seu design no visualizador on-line - qual é a aparência dele?
· Verifique com antecedência para que você tenha tempo de ajustar seu design, se necessário.

O pacote do InDesign
Ao fazer o upload do IDML pela primeira vez, é sempre melhor criar um pacote que inclua as fontes. Ele também mostrará o texto sobre o conjunto e outras informações úteis sobre o arquivo. O IDML subsequente pode ser exportado com Apple E ou Ctrl E e adicionado ao pacote original. A plataforma Workiva precisa apenas de IDML e das fontes que estão sendo carregadas para criar XHTML
Relatório de discrepância
Ao converter IDML>XHTML, um arquivo adicional agora fica junto com o arquivo XHTML com o apêndice 'report' no nome. Esse arquivo fornece informações sobre sua conversão e destacará os problemas, se houver. Os designers são incentivados a visualizar esse relatório após a conversão.











Muitos órgãos reguladores agora estão estabelecendo um limite de tamanho de arquivo de no máximo 100 MB.FC O R iElESeS E N TsI ALiSze

Como interromper um pesadelo de arquivamento ou download? Como você pode reduzir o tamanho do seu relatório? Continue lendo para ver dicas que os designers podem usar para otimizar o tamanho dos arquivos.
Para o designer no InDesign
Aqui estão algumas coisas que o designer precisa fazer para reduzir o tamanho do arquivo final no software Adobe InDesign:

A exportação de IDML é uma desintoxicação de tamanho de arquivo, mas aqui estão algumas outras coisas que você pode fazer antes de exportar:




O código XHTML produzido pela plataforma Workiva é limpo e otimizado, o que ajuda no tamanho do arquivo e na velocidade de download. Essencialmente, tudo o que não é necessário é removido. Recomenda-se que os clientes verifiquem com seu órgão regulador de arquivamento qual é exatamente o limite de tamanho de arquivamento naquela jurisdição.

· Evite parágrafos vazios para obter espaço extra em seu documento.
· Certifique-se de que todo o conteúdo tenha um nome de estilo anexado.
· Certifique-se de cortar todas as suas imagens no tamanho correto, 100% e RGB
· Revise a incorporação de fontes em SVGs, verifique se está usando fontes comuns da Web ou apenas contorne o texto.
· Revise cuidadosamente seus SVGs e certifique-se de que está usando os pontos ideais para criar uma forma. Conseguimos reduzir um mapa-múndi SVG de 5 MB para 200k otimizando o número de pontos usados no software Adobe Illustrator sem criar nenhuma diferença visual.
· Pense cuidadosamente se todas as suas imagens são necessárias.
· Certifique-se de ter reduzido suas imagens para 72 dpi - a resolução para sites.
· Exportar como IDML e reimportar para o software InDesign no final do processo pode reduzir o tamanho do arquivo, pois pode eliminar códigos desnecessários e livrar-se de plug-ins de terceiros.
· Remova todos os objetos não utilizados
· Excluir estilos não utilizados
· Exclua tudo o que restar nos quadros de colagem ou em qualquer página mestra extra




Descubra antecipadamente o limite de tamanho do seu arquivo e verifique se está dentro desse limite












Formas Essenciais extras

Pfavor estar ciente de que não apoiamos todos os aspectos das formas. É melhor testar aspectos de seu trabalho artístico para que os resultados possam ser avaliados.
As formas sempre podem ser facilmente convertidas em SVG exportando-as do software InDesign para o software Adobe Illustrator e salvando-as no formato SVG a partir daí. Em seguida, substitua as formas no software InDesign pelas imagens SVG.
É melhor usar um SVG posicionado em vez de várias formas repetidas do InDesign, pois isso reduzirá significativamente o tamanho do arquivo.
Tenha cuidado ao copiar e colar ativos em, o software InDesign. É sempre melhor "colocar
ativos sempre de novo, mesmo que sejam o mesmo ativo.
Rastrear alterações
Se houver conteúdo que não seja da Workiva no arquivo do InDesign, certifique-se de que todas as alterações de faixa sejam confirmadas se estiverem sendo usadas.
Plug-ins de terceiros
Certifique-se de que eles sejam removidos ou que o uso deles não interfira no conversor de IDML para XHTML da Workiva.
Cores
Evite cores muito próximas. Os gradientes de cores entre si devem ser evitados, pois no momento isso não pode ser convertido em XHTML.

Spreads
O XHTML renderiza uma página por vez, portanto, tenha cuidado ao acessar com spreads. Os PDFs podem ser configurados como spreads para serem visualizados em, mas esse não é o caso do XHTML. Você pode adicionar um visualizador XBRL ao seu relatório e, com a contribuição da sua equipe da Web, pode adicionar o recurso de propagação. No entanto, isso não está disponível em código aberto.
Margens
As margens espelhadas não têm lugar em um meio digital e são um recurso "somente para impressão".
Guias
As guias não existem em XHTML. As guias não devem ser usadas para alinhamento durante a conversão para XHTML.
Colunas
O ICML exporta em formato galley. Essa é uma coluna contínua de medida única. Ele é colocado em colunas no software InDesign. O ICML não exporta várias colunas.
Na plataforma Workiva, você pode ter um layout de até 7 colunas. No entanto, para a exportação do ICML para o software InDesign, o layout da coluna não é essencial na plataforma, pois a exportação envia

conteúdo no formato galley (uma coluna), independentemente da configuração no Workiva. O designer pega o conteúdo e preenche as colunas no software InDesign. O design do documento do InDesign criará o XHTML, não o design na plataforma Workiva.
Conteúdo alienígena
Para a garantia dos dados, o conteúdo do relatório principal é criado na plataforma Workiva e esse
permanece vinculado ao software InDesign, no qual o designer pode projetar sem ajustar acidentalmente o conteúdo. O Workiva é o documento principal aqui. No entanto, nem todo o conteúdo precisa estar na plataforma Workiva. Então, quando o conteúdo extra do seria adicionado ao software InDesign?
Legendas das fotos
Se o design estiver sendo feito no software InDesign, as imagens não precisarão ser adicionadas à plataforma Workiva. Os designers podem criar legendas de imagem conforme necessário. Eles devem ser estilizados e não são afetados nas importações subsequentes do ICML.
Cabeçalhos e rodapés
Elas não são exportadas da plataforma Workiva, portanto, precisam ser criadas com as páginas mestras do InDesign.

Rastreamento e kerning
O software InDesign é renderizado apenas uma vez, portanto, o que você vê na tela é o posicionamento exato do conteúdo. Na Web, isso é diferente. A Web é renderizada sempre que você abre uma página, portanto, os designers devem estar cientes das limitações da Web. O texto justificado, por exemplo, pode ter
diferentes finais de linha, dependendo do zoom ou do tipo de navegador que está sendo usado.
Composição tipográfica
A composição tipográfica é feita na plataforma Workiva, não no software InDesign. Na plataforma Workiva, não use um retorno suave. Um retorno suave é quando você pressiona Shift Enter. Isso cria uma quebra de linha em vez de uma quebra de parágrafo. Você pode ver as devoluções simples e complexas pressionando o ícone Mostrar/Ocultar caracteres não imprimíveis na faixa de opções superior. Se as palavras não devem ser quebradas (como em um nome), use um espaço sem quebra
no meio. Vá para Insert>Symbol>Special Characters>Nonbreaking Space.
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O F X H T M L A N D I N D E S I G N C O M P A T I B I L I D A D E Glossário


Definição de símbolos


Compatível com o InDesign Estes são os recursos do software InDesign que são compatíveis com a exportação de IDML> XHTML

Advertência
Esses recursos precisarão de consideração ou aplicação cuidadosa se forem renderizados em XHTML




Evitar
Esses são recursos do software InDesign que não são compatíveis com a exportação IDML> XHTML

 Informações sobre recursos
Esses são apenas recursos do InDesign que não têm relação com o XHTML


Observe que foram adicionados atalhos comuns, mas eles podem variar de acordo com a plataforma e a versão do software InDesign. Os atalhos mencionados neste guia são para Macs.
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Evitar
Advertência
Compatível
Informações

Evitar
Advertência
Compatível
Informações

[image: ]Alinhar
Janela > Objeto e layout > Alinhar
[image: ]Essa ferramenta pode alinhar caixas de texto ou imagens à esquerda, à direita, horizontalmente e espaçar itens de maneira uniforme.
Alinhamento
[image: ]Alinhamento como um estilo de parágrafo - justificado, centralizado, à esquerda ou à direita.
Alinhar ao alinhamento da página
Esse recurso não é compatível com o processo de conversão de XHTML.
[image: ]Ancoragem
É quando algo é anexado a outro objeto (ou seja, uma legenda é ancorada à imagem). Mova a imagem e a legenda a seguirá automaticamente, exceto nas células da tabela. Por favor
não use imagens ancoradas no texto. As imagens colocadas nas células da tabela são ancoradas automaticamente e nós oferecemos suporte a esse recurso.
[image: ]Não coloque itens agrupados em células de tabela. Eles não podem ser renderizados.
 Ponto de ancoragem
Painel Ferramentas > Ferramenta Ponto de Ancoragem
Dá controle sobre o caminho de um traço ou forma para alterar manualmente sua direção ou curvas.

 Links de ativos
Janela > Links
No software InDesign, as imagens são vinculadas a partir da área de trabalho. Para IDML, essas imagens precisarão ser incorporadas. Para fazer isso, clique com o botão direito do mouse na imagem no painel Links e clique em Embed Link. A imagem agora é um recurso permanente
do arquivo. Apenas para observar que as imagens incorporadas são um requisito do ESEF e devem estar em base64.
Organizar
Janela > Organizar
Isso permite que você ordene um item selecionado para o verso ou para a frente do documento na mesma camada. Isso é chamado de índice z na terminologia da Web.

Grade de linha de base
A grade de linha de base não é compatível com XHTML. Se estiver usando uma grade de linha de base, os designers precisarão levar seus estilos de parágrafo o mais longe possível para replicar o efeito.A
A
B

Mudança de linha de base
A linha de base é uma linha invisível onde as letras se encontram. O deslocamento da linha de base move o texto para cima ou para baixo a partir da linha de base. Selecione o texto e, em seguida, Option/Shift seta para cima ou para baixo.
Sangramento
O sangramento é uma função de impressão. As imagens que devem ir até a borda precisam de fato ultrapassar a borda e, em seguida, ser cortadas pela impressora. Nosso conversor também fará o corte.












[image: ]LivroB
C
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Arquivo > Novo > Livro
O formato de livro do InDesign é uma coleção de documentos do InDesign que compartilham o mesmo formato e podem ser numerados sequencialmente. Um livro pode ter vários documentos. Não oferecemos suporte ao formato de livro do InDesign. O XBRL profiler reúne várias conversões.
[image: ]Texto do corpo
O único estilo de parágrafo que é atualizado a cada vez com o ICML é chamado de 'Bodytext'.
Precisamente escrito desta forma. Isso ocorre porque ele é usado para substituir o estilo padrão "Normal". Todos os outros nomes de estilo da plataforma Workiva NÃO atualizarão os estilos do InDesign quando estiverem lá.

 Máscara de recorte
[image: ]Essa é uma forma (contêiner) e uma imagem (preenchimento). Só oferecemos suporte a um único objeto, imagem ou forma dentro da máscara de recorte. Não oferecemos suporte para que itens agrupados tenham uma máscara de recorte aplicada a eles.
[image: ]Comentários
Os clientes/designers devem usar a função de comentário na plataforma Workiva e não deixar comentários no texto. No momento, não há como passar comentários para o software InDesign.
[image: ]Cores
A Workiva usa cores RGB para uso na web. Para exportação IDML, somente cores RGB.

Estilos de personagens
[image: ]Os estilos de caracteres são exportados via ICML e oferecemos suporte a estilos de caracteres na conversão IDML> XHTML.
[image: ]Colunas
A plataforma Workiva pode suportar o layout de várias colunas, até sete de mesma largura.
No entanto, o conteúdo da exportação ICML tem apenas uma coluna por padrão (galley). O site pode preencher muitas colunas no software InDesign. O layout do InDesign prevalecerá no XHTML.
[image: ]Cantos (arredondados)
Objeto > Opções de canto
Isso alterará o tamanho e a forma do canto. Esses são chamados de Squarcles. Oferecemos suporte a cantos arredondados em IDML>XHTML.



Considere todas as resoluções de tela. O contraste insuficiente de cores limita a acessibilidade da Web para alguns usuários













[image: ]Tampa com gotaD
E
F

Esse efeito tipográfico é muito usado em impressos e não tanto em XHTML. O drop cap pode estar em várias linhas com uma ou
[image: ]vários caracteres no início de um parágrafo. Temos suporte limitado para drop caps, portanto, faça um teste completo. A solução alternativa recomendada é adicionar uma imagem para a tampa suspensa.
Sombra de gota
Esse efeito não é compatível com a IDML e deve ser evitado.
[image: ]Descendente
[image: ]Uma letra descendente é uma letra que fica abaixo da linha de base, por exemplo, "y". A cauda de "y" é um descendente.

Efeitos
[image: ]Objeto > EfeitosFontes
A primeira coisa a verificar é se o seu cliente tem direitos de uso da Web para todas as fontes usadas no relatório. É recomendável que o contrato de licenciamento contenha uma licença de fonte da Web. Qualquer fonte (TTF ou OTF) pode ser usada porque o IDML>XHTML consumirá e converterá as fontes carregadas.
Certifique-se de que eles estejam incluídos na exportação IDML.
Wingdings ou Zapf Dingbats devem ser usados com cuidado e testados em XHTML.
Páginas de rosto
Criado no software InDesign para layouts de impressão. As páginas na saída XHTML serão exibidas em ordem, mas somente em páginas únicas. No entanto, o leitor iXBRL pode ser desenvolvido para exibir spreads.
Preencher
Atalho X
Para essa ferramenta, você define uma cor e preenche um quadro.
Considere fontes de código aberto para licenciamento e adequação à web

[image: ]Somente a transparência é suportada. Não há suporte para gradientes.
Ferramenta Ellipse
[image: ]Use essa ferramenta para criar ovais (elípticas) ou círculos (mantendo pressionada a tecla Shift) que estarão prontos para receber cores e/ou texto.
Ferramenta de moldura de elipse
[image: ]Isso é usado para criar um quadro no qual colocar uma imagem.
Exportação
Exportação para o formato IDML para conversão em XHTML.







	As variantes sutis não são exibidas em todas as telas
Para o ESEF, as fontes precisam ser incorporadas ao arquivo como código base64.













[image: ]GlifosG
G
G

Janela > Tipo e tabelas > Glifo
Um glifo é uma letra/símbolo que compõe uma fonte. Essa paleta mostrará todos os glifos disponíveis na fonte selecionada. O IDML converterá esses símbolos em código (por exemplo, @ = &#64;).
[image: ]Ferramenta de lacunas
Atalho U
Isso altera o tamanho dos objetos, mas mantém o espaço entre eles.
[image: ]Gradientes
Um gradiente é uma mistura fluida entre uma cor e outra ou de uma tonalidade para outra tonalidade da mesma cor. Não é possível converter com precisão os gradientes do InDesign em XHTML.

Ferramenta Gradient Feather
[image: ]Turno G
[image: ]Essa ferramenta permite que você desvaneça um objeto/forma de opaco para transparente. Um ponto a ser observado é que gradientes sutis não aparecem na Web devido à resolução da tela.
Ferramenta Gradient Swatch
Atalho G
Você pode ajustar o gradiente aqui.
[image: ]Grades - Grade de linha de base
Exibir > Extras > Mostrar grade de linha de base
A grade da linha de base é uma estrutura usada para alinhar o texto. Ele é mostrado apenas na área imprimível. Ele não é compatível com IDML>XHTML.

Grades - Grade de documentos
[image: ]Exibir > Extras > Mostrar grade de documentos
Essa grade se estende até a área não imprimível ao redor da página (a área de transferência) para que os atributos possam ser armazenados para uso posterior.
[image: ]Grupo
Objeto > Agrupar / Desagrupar
A ferramenta Group coleta qualquer item no software InDesign e mantém as coordenadas XY ao mover ou girar o grupo. O XHTML não é compatível com itens agrupados, portanto, é necessário desagrupar todos os itens agrupados antes da conversão.
[image: ]Guias
Layout > Create Guides (Layout > Criar guias)
Você pode arrastar manualmente as guias da barra de régua. Isso é usado para criar guias individuais em vez da grade do documento.












[image: ]Ferramenta manualH
I
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Atalho H
[image: ]Essa ferramenta é usada para pegar o documento real e mover-se na tela entre as páginas ou spreads.
Hifenizar
Localizado no painel Parágrafo
Se você marcar a opção hifenizar em um estilo de parágrafo, isso permitirá que as palavras sejam quebradas no final de
a linha para a nova linha automaticamente. Essa é uma função do InDesign e é parcialmente compatível com a conversão de XHTML.
Em alguns idiomas, o gerenciamento da hifenização é muito importante. É recomendável que os designers que estejam usando essas linguagens testem exaustivamente o conversor IDML>XHTML para garantir que obtenham os efeitos desejados.
[image: ]Estilos hierárquicos
Oferecemos suporte à herança (com base em) em paletas de estilo, parágrafo, caractere e célula.

Informações
[image: ]Janela > Info
Realce o texto e clique em window>info e ele exibirá quantos parágrafos, linhas, palavras e caracteres. Essa é uma boa ferramenta para os clientes saberem quantas palavras precisam para preencher uma área de texto.
[image: ]Intenção
Arquivo > Novo documento > Intenção
É aqui que você pode definir a intenção do documento (por exemplo, impressão, web ou celular). Isso cria tamanhos de página adequados para o uso ou a plataforma. Nas versões mais recentes para Web e dispositivos móveis, há guias em que você pode definir o tamanho. Para o ESEF, o relatório é exibido em um formato estilo pdf, portanto, a configuração da página da Web ou móvel não é necessária.

Kerning
Paleta de caracteres ou comando T
É aqui que você pode aumentar ou diminuir o espaço entre os caracteres individuais. O kerning pode ser definido somente no software InDesign. Há uma função de espaçamento entre palavras na plataforma, mas ela não é exportada no ICML. Ainda não está claro até onde iremos para dar suporte ao kerning em IDML para XHTML. É certo que o apoiaremos como parte de um estilo e é certo que
não o apoiaremos como uma substituição. Isso significa que os designers que quebram o link ICML para usar técnicas de kerning para o gerenciamento de viúvas não podem mais fazer isso.












[image: ]Alimentação principal/linhaL
L
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[image: ]O espaçamento é o espaço vertical entre as linhas do texto. Ele é medido de uma linha de base para outra. O padrão do InDesign é 120%. Você pode alterar a entrelinha no painel de estilos de parágrafo do InDesign.
Camadas
Janela > Camadas
As camadas ajudam a organizar um documento. A visibilidade de cada camada pode ser ativada ou desativada. Você pode bloquear uma camada para evitar que os itens dessa camada sejam selecionados. Ele é usado com frequência por designers para criar visuais de design para os clientes. As camadas também podem ser usadas para comentários. Exclua todas as camadas ocultas e as camadas usadas para fins administrativos.

Números de linha
[image: ]Alguns designers adicionam números de linha como um recurso de desenvolvimento no software InDesign, geralmente em uma camada oculta. Os designers devem excluí-los antes da criação do IDML.
[image: ]Ferramenta de linha
Atalho \
Isso cria uma única linha. Ele pode ser editado no painel Traço (janela>traço), ou seja, peso, cor etc.
[image: ]Manter a tecla shift pressionada mantém a linha vertical ou horizontal.
Links (ativos)
Janela > Links
No software InDesign, as imagens do são vinculadas a partir da pasta da área de trabalho. Para IDML, essas imagens precisarão ser incorporadas. Para fazer isso, clique com o botão direito do mouse na imagem no painel de links e clique em Embed Link. A imagem agora é um recurso permanente do arquivo.

 Layout líquido
[image: ]Janela > Interativo > Layout líquido
Isso permite tamanhos de página diferentes em seu documento e não deve ser usado para exportação de IDML.
[image: ]Listas
O software InDesign suporta apenas 6 níveis de listas, enquanto a plataforma Workiva suporta mais.
[image: ]Muitos designers estão se afastando das listas encapsuladas. Se você precisar usar mais de 6 níveis, basta criar o número correto de estilos de parágrafo com o recuo e o espaço acima/abaixo apropriados.
Trava
Objeto > Bloqueio
Isso bloqueia os elementos para que você não possa movê-los acidentalmente. Os designers devem desbloquear antes de exportar.


	
Remova as camadas ocultas antes da conversão para XHTML

Para o ESEF, as fontes precisam ser incorporadas ao arquivo como código base64.













[image: ]MargensM
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Layout > Margens e colunas
Com um novo documento, use essa função em sua página principal e isso será definido
[image: ]em todo o documento. Clique em cada página se quiser ajustar as páginas posteriormente.
Marcadores
Type > Insert Special Character > Markers (Numeração de página)
Aqui você precisa criar um quadro de texto e clicar em marcadores. Se isso for feito no documento mestre, ele aparecerá em todas as páginas que foram criadas a partir da página mestre. Nós
[image: ]suportam números de página, mas não suportam variáveis de texto.
Páginas Mestre
Janela > Páginas
As páginas mestras são simplesmente modelos configurados com atributos comuns, por exemplo, cabeçalhos e rodapés, numeração de páginas, logotipo etc. Você pode criar mais mestres (por exemplo, modelos à esquerda e à direita para spreads). Você arrasta a página mestra para o painel Página para colocar esses itens.
[image: ]Ferramenta de medição
Atalho K
Essa ferramenta mede entre dois pontos e aparece na barra de informações.

Recuos negativos
Não há suporte para recuos negativos em XHTML.
Estilos aninhados
Extremo direito da barra de aplicativos > Drop Caps e estilos aninhados
Um estilo aninhado é um estilo dentro de um estilo de parágrafo. Ele substituirá efetivamente o estilo de parágrafo. Isso não é compatível com outras hierarquias de estilo.
[image: ]Notas
Tipo > Notas
Aqui você pode deixar anotações ou comentários para revisão.
[image: ]Opções de numeração e seção
Layout > Numeração e opções de seção
Ao criar um relatório grande, isso ajuda na navegação.
As seções são mostradas nas miniaturas no painel de páginas. Oferecemos suporte à numeração automática de páginas.

Objeto
Menu superior > Objeto
Um objeto no software InDesign é qualquer coisa que possa ser editada, ou seja, um quadro de texto ou uma imagem.
Com esse menu suspenso, você pode enviar o objeto para trás ou para frente, adicionar efeitos como sombra ou transparência. Oferecemos suporte a atributos limitados de estilos de objeto. Borda, plano de fundo e cor.
Regiões observadas
A plataforma Workiva usa o conceito de regiões observadas por vários motivos, incluindo a marcação XBRL. Isso é refletido no software InDesign usando o painel de marcação e pode ser visto como colchetes multicoloridos ao redor do conteúdo do ICML. Esses suportes não afetam o design de forma alguma.
Ao dividir um número de quadros de texto, não divida em uma região observada, indicada pelos colchetes mostrados abaixo.
[open/.... split	./closed]












[image: ]Alinhamento da margem ópticaO
P
P

Menu superior > Window > Type & Tables > Story
Essa ferramenta deslocará caracteres como marcas de fala para criar uma linha mais limpa. Veja o exemplo abaixo. Não apoiamos isso.Exemplo de margem óptica















[image: ]Impressão sobreposta
Exibir > Visualização de impressão sobreposta
As cores spot são usadas quando a precisão das cores é fundamental. Essa visualização mostrará com mais precisão a aparência real das cores na impressão. Não oferecemos suporte a cores especiais. Elas podem ser alteradas no software InDesign na paleta de cores que afeta os ICMLs vinculados.

Pacote
[image: ]Arquivo > Pacote
Isso é usado ao enviar o arquivo do InDesign para outra pessoa ou é uma boa prática para suas próprias informações. Isso reúne todos os ativos em uma única pasta.
[image: ]Numeração de páginas
No painel de páginas, clique duas vezes nas páginas mestre. Adicione um quadro de texto grande o suficiente para seu maior número. Adicione um quadro de texto às páginas mestras esquerda e direita, se aplicável. Adicionar texto,
se necessário, por exemplo, 'page' e, em seguida, posicione onde você deseja que o número fique e
Type > Insert Special Character > Markers > Current Page Number
Por padrão, a numeração é 1,2,3 etc.
Para uma numeração diferente - Layout > Numbering & Section Options
[image: ]Painel de páginas
Janela > Páginas
Você pode navegar pelas suas páginas usando o Painel de páginas. Aqui você pode adicionar mais páginas, excluir ou duplicar.

Ferramenta de página
Turno P
Isso apenas altera o tamanho de uma página em seu documento. Isso não afetará as outras páginas.
[image: ]Painel de parágrafos
Janela > Tipo e tabelas > Parágrafo
Isso é usado para parágrafos individuais em vez de usar estilos de parágrafo. Não oferecemos suporte a substituições.
[image: ]Controles de formatação de parágrafo
Barra superior do aplicativo
Contém vários controles de estilo. Acesse clicando no "A" que está no canto superior esquerdo. Não oferecemos suporte a substituições.
Colar/colar em
Editar > Colar / Colar no local
Por favor, coloque todas as imagens. Não corte e coloque múltiplos de uma imagem. Isso inclui a colagem em formas.












[image: ]PasteboardP
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Exibir > Toda a Pasteboard
A Pasteboard é a área inteira, incluindo a área para conteúdo não impresso.
[image: ]Ferramenta de caneta
Atalho P
Isso cria linhas personalizadas.
[image: ]Ferramenta Pencil
Atalho N
Essa ferramenta cria linhas como a ferramenta caneta, mas com mais flexibilidade.
[image: ]Local
Arquivo > Local
As imagens devem sempre ser colocadas em vez de coladas. As imagens devem ser colocadas em 100%, de preferência para otimizar o tamanho do arquivo. As imagens também devem ser ajustadas ao quadro que ocupam. Em outras palavras, as imagens devem ser cortadas de acordo com o quadro.
Limpar todos os itens da área de trabalho para uma conversão mais rápida

[image: ]Plugins
Todos os plug-ins devem ser desconectados antes da exportação do IDML.

Ferramenta Polígono
[image: ]Painel de ferramentas > Clique com o botão direito do mouse > Polígono
Isso é suportado. Tenha cuidado ao colocar itens agrupados em um polígono, pois isso não será convertido.
[image: ]Pré-voo
Janela > Saída > Preflight
O Preflight verifica se há erros antes de exportar e empacotar em um arquivo zip - coisas como arquivos ou fontes ausentes, imagens de baixa resolução e excesso de texto.
[image: ]Perfis
Editar > Atribuir perfis
Aqui você pode alterar as cores do documento sem converter cores (por exemplo, RGB para CMYK).

 Ferramenta Rectangle
Atalho M
Isso cria um quadro retangular pronto para receber texto/cor etc. Manter a tecla shift pressionada cria um quadrado. Oferecemos suporte a isso como um quadro de texto ou imagem.
[image: ]Relink
Window > Links ou na parte inferior do painel de links
Imagens, etc., que foram renomeadas/movidas podem gerar um erro e é aqui que você pode fazer o relink.
[image: ]Reverter
Arquivo > Reverter
Isso retorna à versão anterior de seu documento. Certifique-se de que você tenha o ICML atual.
[image: ]Girar o spread
Exibir > Girar spread
Isso serve apenas para trabalhar em seu documento. Ele não altera a impressão ou a exportação de IDML.
Girar conteúdo
Oferecemos suporte a conteúdo rotacionado
Governantes
Exibir > Mostrar réguas
As réguas podem ser arrastadas de cima para baixo ou para a esquerda.












[image: ]Ferramenta de escalaS
S
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Atalho S
Pegue a alça do quadro e redimensione.
[image: ]Ferramenta de tesoura
Atalho C
Isso corta um quadro ou caminho.
[image: ] Modo de tela
View > Screen Mode ou W
Isso alterna entre o modo de edição normal e a visualização.
[image: ]Separações
Window > Output > Separations Preview (Janela > Saída > Visualização de separações)
Isso mostra todas as cores que estão sendo usadas e permite verificar quando uma cor está sendo impressa sobre outra (por exemplo, knockout ou impressão sobreposta). Esse é um recurso exclusivo do software InDesign.
[image: ]Ferramenta de corte
Atalho O/ Object > Transform
Isso altera as formas para criar um efeito mais 3D, inclinando um objeto. Isso é suportado.
[image: ]Lesma
Arquivo > Novo documento > Sangramento e barra
Slug é uma função que não é usada com frequência. É usado para deixar instruções fora da área impressa e fora da área de sangria.

Roteiro de história dividida
Para exportação de IDML, não divida um item com marcadores em quadros de texto. A lista pode estar em vários quadros, mas não em um marcador individual.
[image: ]Ferramenta suave
Painel de ferramentas > No menu suspenso da ferramenta Pencil Tool
Isso remove/simplifica os pontos de ancoragem nas formas. Ao colocar muitas formas em um documento, os designers precisam estar cientes do número de pontos em uma forma. É melhor
otimize-os para obter uma conversão bem-sucedida e um tamanho de arquivo ideal.
Spreads
[image: ]Observe que, no caso de IDML>XHTML, processamos páginas, página por página. Os leitores de iXBRL podem exibir spreads, embora isso exija algum desenvolvimento da Web por parte da sua equipe. Observe que spreads com mais de três páginas não podem ser usados.
Derrame
Janela > Traçado
[image: ]Com esse painel, a aparência das linhas pode ser alterada.
Estilos
Janela > Estilos
Isso deve ser usado para definir Parágrafo, Caractere e Célula. Isso economiza tempo e

deve ser usado de forma consistente em todo o documento.
Observe que somente a borda e o plano de fundo dos estilos de objeto são compatíveis.
[image: ]SVG
A ESMA não permite a tag <object> ou <svg> portanto, a apresentação em linha não é permitida, pois não é possível ler as fontes.
Para garantir que o arquivo SVG seja exibido corretamente, se incorporado em uma página da Web:
1. abrir o arquivo SVG em um programa de ilustração
2. converter todos os caracteres de fonte em caminhos de contorno
3. reexportar o arquivo SVG e incorporar esse arquivo
Como alternativa, você pode usar fontes da Web para garantir que as fontes necessárias estejam disponíveis no servidor da Web.
[image: ]Amostras
Janela > Cor > Amostras
Esse painel é sua biblioteca de cores ou tonalidades. Depois que uma cor é aplicada, assim como os estilos de parágrafo, as edições feitas em uma opção de cor alterarão todas as instâncias dessa cor no documento.












[image: ]Medidas da mesaT
T
T

[image: ]A plataforma Workiva mede as tabelas em pixels. Por padrão, o software InDesign mede em pontos, mas também pode medir em mm, picas e outras formas de medição. Para definir a largura correta do corpo do texto no InDesign para a largura desejada da tabela, defina as unidades do In Design como pixels e, assim, você terá paridade com a plataforma.
Tabela
Guia Table (Tabela) no menu superior.
Aqui estão os recursos usuais do número de colunas, linhas, incluindo altura e largura.
Não oferecemos suporte a substituições de tabela de nenhuma forma para exportação de XHTML.
Células da tabela
Evite colocar um quadro de texto em uma célula de tabela. Não apoiamos isso.
Cor do texto - herdada
[image: ]Não oferecemos suporte a cores de texto herdadas. Esse é um recurso do software InDesign que geralmente usa a regra acima/abaixo. Especifique uma cor real da paleta de cores.
Molduras de texto
O texto em um quadro de texto NÃO retangular não será suportado. Use apenas quadros de texto retangulares.

Guias
As guias não devem ser usadas. Sempre!
Tópicos de texto
Exibir > Extras > Mostrar linhas de texto
As linhas de texto mostram os quadros de texto que são vinculados para criar um único fluxo de texto. Você pode vincular um quadro de texto clicando no quadrado no canto inferior direito da caixa de texto e, em seguida, clicando novamente no quadro de texto seguinte. Todos os quadros de texto vinculados devem ser divididos antes da conversão.
[image: ]Quebra de texto
Janela > Quebra de texto
Esse painel envolve o texto em imagens ou formas. Não apoiamos isso.
[image: ]Rastreamento
Windows > Tipo e tabelas > Caractere
Isso reduz ou aumenta os espaços entre os caracteres em uma sequência de texto. Isso rastreia tudo de volta e ajusta o espaço em branco proporcionalmente de volta. Isso pode ser feito como parte do caractere e do parágrafo, mas não pode ser aceito como uma substituição.

Transformar
[image: ]Objeto > Transformar
Aqui você pode inverter horizontal ou verticalmente, dimensionar, girar ou cortar. Cisalhamento é quando você inclina um objeto. Se uma imagem for convertida incorretamente, verifique qualquer transformação feita no InDesign.
[image: ]Tipo de ferramenta
Atalho T
Essa ferramenta cria um quadro de texto
Use a Type Tool para criar um quadro de texto (basta clicar e arrastar) para inserir texto ou clique uma vez em um quadro ou forma existente para transformá-lo em um quadro de texto.
[image: ]Ferramenta Digitar em um caminho
Turno T
Primeiro, você precisa usar a Pen Tool para criar um caminho. Em seguida, clique na ferramenta Tipo de caminho, vá até o caminho e clique apenas uma vez onde deseja que o texto comece. Em seguida, digite e suas letras seguirão o caminho.
Importante - As guias não existem na Web!
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Preferências > Unidades e incrementos
Você pode definir suas preferências aqui para as medições. Normalmente, os pixels são usados para design da Web, portanto, devem ser selecionados para serem compatíveis com a plataforma Workiva.

Variáveis
[image: ]Tipo > Variáveis de texto
As variáveis de texto podem ser usadas em textos e quadros de texto. Essas mudanças dependem de vários fatores. Paginação, seção, datas, cabeçalhos em execução são algumas das maneiras pelas quais eles são usados.
Discutiremos se apoiaremos alguns desses itens em determinadas circunstâncias.

Wingdings
[image: ]Nem todos os navegadores entendem Wingdings, Webdings e Zapf Dingbats. Melhor evitar. O suporte a unicode é limitado.
[image: ]Espaço de trabalho
Janela > Espaço de trabalho
O Workspace controla quais painéis estão disponíveis na tela. Você pode clicar novamente em "Essentials" para arrumar seu espaço de trabalho.
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Arquivo > Importar XML
XML ou Extensible Markup Language é um conjunto de ferramentas para dados. O software InDesign pode trabalhar com arquivos XML. Com essa estrutura, você pode marcar o conteúdo do seu arquivo do InDesign e usar esses dados estruturados para uso em outros aplicativos.
As tags XML podem ser mapeadas para estilos a fim de facilitar a formatação desse conteúdo. Existem sistemas que funcionam dessa forma.
O exportador ICML usa a estrutura XML integrada do software InDesign para facilitar a passagem das regiões observadas da plataforma Workiva para o ICML, para serem mantidas no software InDesign e exportadas via IDML para conversão em XHTML. Essas tags do InDesign são usadas para preencher o XBRL no momento da conversão.

Zapf Dingbats
Nem todos os navegadores entendem o Zapf Dingbats. Melhor evitar.
Navegador Zoom
Observe que alguns navegadores completam os valores com base nos níveis de zoom. Por exemplo, os pesos das regras de linha podem parecer diferentes de acordo com o navegador e a escala usada.
[image: ]Ferramenta de zoom
Atalho Z
Essa ferramenta faz exatamente o que diz e também é ótima para movimentar um spread.
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Configuração do documentoPERGUNTAS E RESPOSTAS

Pergunta: Posso ter meu relatório em um formato de paisagem?
Resposta: Sim! Você pode escolher o layout nas propriedades do documento e nós oferecemos suporte a paisagem em xHTML. Muito melhor para as telas.
Pergunta: Como funciona a configuração do arquivo? Vocês pegam os arquivos do InDesign dos últimos anos e os convertem na plataforma Workiva?
Resposta: Se você tiver o arquivo do InDesign do ano passado, a maneira mais fácil é exportar como um arquivo do Microsoft Word a partir do software InDesign. Em seguida, importe esse arquivo Word para a plataforma Workiva. Verifique se todos os estilos foram aplicados. Observe que o tamanho máximo do arquivo a ser carregado na plataforma Workiva é de 250 MB.
Pergunta: Há um limite para o tamanho das seções em que o documento é dividido?
Resposta: É uma prática recomendada que o esboço reflita o menu/submenu de seu relatório. Isso facilita a navegação do designer pelos ICMLs. Nomeie suas seções para refletir o conteúdo.

Configuração da tabela
Pergunta: Minha(s) mesa(s) está(ão) faltando!
· Se estiver usando a localização no software InDesign, informe isso ao seu CSM. Isso pode afetar as tabelas.
· Verifique o estilo que envolve a tabela em, o software InDesign. O padrão em nossa exportação ICML é Bodytext. É possível que outros estilos/parâmetros possam causar efeitos imprevistos.
· Certifique-se de que suas tabelas sejam de fato tabelas, e não conteúdo com abas, por exemplo, material de "Índice".
Pergunta: E quanto aos estilos de tabela? Resposta: A plataforma Workiva exporta um estilo de tabela no ICML e ele é aplicado a todas as tabelas. Os ajustes podem ser feitos universalmente em toda a
documento por meio dos estilos de tabela no software InDesign.
Pergunta: Quero ajustar um estilo de célula para uma tabela em meu relatório, mas sem afetar as outras tabelas
Resposta: Se você quiser isolar uma única tabela, faça isso adicionando uma cor de fundo clara que não seja usada em nenhum outro lugar do relatório. Isso tornará essa tabela visível para o designer, que poderá então editar esses estilos de célula exclusivos, pois a tonalidade de fundo exclusiva gerará estilos exclusivos.

Pergunta: O que são os colchetes coloridos ao redor dos números na seção financeira?
Resposta: Esses suportes coloridos não afetam o design. Elas estão lá como espaços reservados para o XBRL e regiões observadas quando você exporta para IDML.
Pergunta: Dois pesos de regra devem aparecer, mas apenas um está sendo exibido no XHTML
Resposta: Essa é a resolução da página no navegador. Use o zoom do navegador para ver com mais clareza os pesos das regras. Os designers precisam estar cientes disso quando
definir pesos de regras. Os pesos de regra abaixo de 1px podem apresentar problemas de resolução em muitos navegadores.
Guias de estilo
Pergunta: Apliquei estilos a todos os documentos no Workiva, mas ainda recebo estilos gerados automaticamente na exportação do ICML. Por que isso acontece?
Resposta: A plataforma Workiva não tem estilos com marcadores na paleta de estilos personalizados. Os marcadores são criados ao tocar na faixa de opções. Portanto, todas as listas com marcadores criarão um estilo gerado automaticamente. É uma boa ideia criar e aplicar um estilo de lista de "marcadores" na plataforma Workiva e depois tocar na faixa de opções. No ICML, o designer pode ver facilmente o estilo do marcador, ignorando os números gerados automaticamente.




Perguntas: Posso adicionar um espaço ao nome de um estilo?
Resposta: Não! Os nomes dos estilos não podem conter espaços. Esse é um padrão CSS. Você pode substituir o espaço por um sublinhado para ajudar na legibilidade, se necessário, ou usar CamelCase.
Pergunta: As folhas de estilo devem ser configuradas no Workiva ou no InDesign?
Resposta: Se você tiver um arquivo existente do InDesign, talvez queira importar esses estilos para a Workiva. Você precisa seguir três etapas para garantir uma importação tranquila.
Você também pode configurar seus estilos na plataforma Workiva e importá-los via ICML para o software InDesign.
Perguntas: Todos os arquivos são vinculados às mesmas folhas de estilo e tudo precisa estar em uma folha de estilo?
Resposta: Todas as seções em um arquivo Workiva estão vinculadas a uma folha de estilo. Você pode copiar folhas de estilo de um documento na plataforma Workiva para outro. Vários documentos podem ser importados para o
Software InDesign no qual os atributos de estilo podem ser manipulados.

Pergunta: Você pode fazer substituições manuais na plataforma Workiva e elas são transferidas de volta para o software InDesign corretamente?
Resposta: A prática recomendada é não usar substituições manuais, pois, em última análise, elas não serão convertidas em XHTML. Se
você precisa usar uma substituição, use um estilo próximo a ele, por exemplo, Bodytext, mas depois clique na cor azul do texto. O estilo fluirá através do ICML para o software InDesign como uma substituição (ou seja, um estilo gerado automaticamente), mas os designers podem encontrar facilmente o estilo, pois ele começará com o estilo que foi aplicado, ou seja, neste caso, Bodytext. A partir daí, os designers podem alterar as características do estilo.
Pergunta: É possível adicionar novos estilos depois que o documento estiver na Workiva?
Resposta: Novos estilos podem ser adicionados a qualquer momento e serão adicionados ao software InDesign via ICML quando esse estilo for usado.

Gerenciamento de cores
Pergunta: Precisaremos imprimir o documento, então como funcionam as cores e a saída final do? Quais são as cores do
Uso da plataforma Workiva e como posso obter meu documento de impressão CMYK e meu PDF RGB?
Resposta:
Por padrão, a plataforma Workiva usa cores RGB e é uma prática recomendada que os designers mantenham o formato de cor RGB até que precisem criar arte-final para fins de impressão. A saída XHTML usa apenas cores RGB. Para os designers que estão preocupados com qualquer atraso na criação de um documento para impressão em CMYK, a configuração da paleta de cores em outro documento
deve ser considerado pronto para ser importado no momento da necessidade.
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Fontes
Pergunta: Meus cabeçalhos estão com a fonte errada!
Resposta:
· Você carregou suas fontes?
· Certifique-se de ter carregado as fontes corretas preenchendo um pacote no software InDesign.
· Certifique-se de que suas fontes sejam TTF ou OTF.
· Certifique-se de que sua fonte não esteja corrompida. Experimente em outro sistema.
Pergunta: Posso usar uma fonte que não esteja na plataforma Workiva?
Resposta: Sim, você pode, desde que o cliente tenha uma licença para essa fonte para uso na Web. A fonte precisará ser incluída na exportação IDML para estar em conformidade com o mandato do ESEF. A fonte usada nos gráficos permanecerá
o mesmo que na plataforma Workiva, pois os gráficos são exportados como SVGs e não podem ser editados no software InDesign.
Pergunta: Posso usar o estilo normal na plataforma Workiva?
Resposta: É uma prática recomendada não usar o estilo "normal" na plataforma Workiva. O motivo é que o software InDesign pode ter problemas com esse estilo padrão, por isso recomendamos que ele seja evitado.

Pergunta: Quais fontes são compatíveis com a plataforma Workiva?
Resposta: Aqui estão as fontes suportadas atualmente. Entre em contato com o Suporte se quiser adicionar essas ou outras fontes à sua conta.
Pergunta: Minha fonte usada no software InDesign pode ser exportada corretamente?
Resposta: Sim, mas você precisa se certificar de que tem direitos de uso da Web. Você precisa verificar sua licença. Muitos direitos de fonte são apenas para impressão. Em caso de dúvida, recomendamos que você use uma fonte de código aberto. As fontes de código aberto do Google podem ser encontradas aqui.
Pergunta: Posso usar qualquer fonte?
Resposta: Wingdings, Webdings ou Zapf Dingbats devem ser usados com cautela e verificados em XHTML. As fontes que estão sendo carregadas no conversor Workiva IDML>XHTML precisam ser TTF ou OTF e devem ter permissões de uso na Web pertencentes ao cliente.
Pergunta: Se um arquivo IDML tiver uma fonte que não esteja na plataforma Workiva, e esse IDML for convertido em XHTML, o que podemos esperar desse arquivo?
Resposta: Se as fontes não estiverem na plataforma Workiva, você precisará fazer o upload das fontes com os arquivos IDML. Novamente, verifique o licenciamento em todas as fontes e pesos.

Layout tipográfico
Pergunta: Tenho texto sobreposto!
Resposta:
· Observe atentamente os quadros de texto em questão. Eles estão desvinculados? Eles foram divididos corretamente?
· Eles foram desvinculados antes de serem divididos?
· Verifique se há conteúdo oculto (excesso de matéria) em seus arquivos do InDesign, mostrado como uma cruz vermelha no canto inferior direito de um quadro de texto.
· Preste atenção ao relatório do pacote do InDesign. Ele indicará o texto sobreposto em determinadas páginas.
Pergunta: É possível exportar texto destacado, tachado ou outros efeitos em linha para o software InDesign?
Resposta: É possível, mas você precisa configurar um estilo personalizado e não usar a faixa de opções para formatação.
Pergunta: Nosso designer tem algumas páginas extras que não estão na plataforma Workiva. O que devemos fazer aqui?
Resposta: Se as diretrizes de estilo forem seguidas corretamente, isso deve ser aceitável para a conversão IDML>XHTML.
Exemplos disso são paginação, legendas de imagens, cabeçalhos e rodapés etc.





Pergunta: O texto justificado pode funcionar em xHTML? Resposta: Não recomendamos que o texto justificado seja usado em uma medida curta (largura da coluna). O software InDesign tem vários controles para texto justificado.
XHTML não
Pergunta: Como faço para adicionar uma quebra de parágrafo no software InDesign?
Resposta: Não é possível adicionar uma quebra de parágrafo no software InDesign. Isso precisa ser feito no Workiva. Qualquer espaçamento extra deve ser obtido com estilos, por exemplo, "SpaceBefore" ou "SpaceAfter". Para manipular texto
no software InDesign, use quadros de texto vinculados para controlar o espaçamento e o posicionamento. Isso significa que o projeto permanecerá no lugar com as importações subsequentes do ICML.
Pergunta: Os cabeçalhos e rodapés são exportados no ICML?
Resposta: Os cabeçalhos e rodapés não são exportados da plataforma Workiva. Os designers podem criá-las nas páginas mestras.
Perguntas: Qual é o status atual do

Notas de rodapé da Workiva e exportação de ICML? Está correto que as notas de rodapé na plataforma podem ser usadas e exportadas em um arquivo de exportação icml separado?
Resposta: As notas de rodapé da plataforma Workiva são exportadas via ICML para um arquivo ICML separado dentro da pasta de esboço relevante. Na plataforma Workiva, eles estão sempre no canto inferior direito. Como eles são separados na exportação ICML, podem ser colocados em qualquer lugar no software InDesign e a garantia de dados ainda é relevante.
Pergunta: No ano passado, nossa paginação mudou drasticamente em uma data tardia. É muito simples reordenar na plataforma Workiva?
Resposta: A paginação é feita no software InDesign. O conteúdo de cabeçalhos e rodapés não é transportado via ICML. Para edição de última hora, consulte o  workshop do Designer   nº 4: fluxo de trabalho avançado.

 Especificação da imagem
Pergunta: Minhas imagens parecem erradas ou estão faltando!
Resposta:
· Verifique se eles estão incorporados, posicionados em 100%, totalmente cortados e com 72 ou 96 dpi
· Verifique se eles não estão invertidos de alguma forma.
· Verifique se a imagem não está usando algum tipo de efeito do InDesign.
· Verifique se não há efeitos secundários na parte superior da imagem, por exemplo, ponto de acesso de gradiente radial.
· Certifique-se de que as imagens na página da direita, começando pela lombada, não se sobreponham à página da esquerda, nem mesmo em 0,0001 pt. Isso fará com que o conversor pense que se trata apenas de uma imagem da página à esquerda.
Pergunta: Como fica a resolução da imagem para um registro do ESEF?
Resposta: Para visualização na Web, o padrão é 72dpi ou 96dpi.





Pergunta: Como os gráficos e as imagens dos arquivos do Adobe Illustrator são exibidos na plataforma Workiva? Elas são uma imagem de espaço reservado ou são totalmente removidas?
Resposta: As imagens podem ser colocadas no Workiva como png/
jpg etc. (não svg). Eles serão exportados via ICML em uma pasta de ativos. Ao usar o processo IDML para criar XHTML, as imagens não são necessárias no Workiva. Eles servem apenas como suporte de localização adicional. As imagens vêm do software InDesign para produzir XHTML se a ida e volta estiver sendo usada.
ICML
Pergunta: Estou trabalhando no software InDesign há algum tempo e acabei de importar outro arquivo ICML. Apareceram colchetes coloridos que não existiam antes. O que é isso?
Resposta: O colchete colorido é um espaço reservado para XBRL e não altera nenhum atributo de design, portanto, ignore-o.

Pergunta: Recebo um monte de estilos estranhos quando importo o ICML para o software InDesign?
Resposta: Estilos extras serão gerados por esses motivos:
· Nenhum estilo foi aplicado na plataforma Workiva
· Um estilo foi adicionado, mas depois alterado com a faixa de opções, por exemplo, negrito ou itálico
· Foi usada uma lista de itens
· Conteúdo vinculado
Pergunta: Quando o arquivo tiver sido exportado para o software InDesign, poderemos continuar a fazer alterações na plataforma Workiva?
Resposta: Sim! É uma boa ideia entrar em contato com sua agência de design quando ela desejar atualizar o conteúdo da plataforma. Depois que você enviar ao designer a exportação do ICML, ele poderá continuar o processo de design. Quando você reenvia o conteúdo atualizado novamente, todo o design feito pelo designer permanece intacto.
Pergunta: Há limitações com relação ao tamanho do arquivo ICML que é enviado ao designer?
Resposta: Como a maioria dos arquivos, eles devem ser limitados a cerca de 5 MB. Arquivos de texto muito grandes podem causar uma queda de memória no InDesign, em parte porque o InDesign

o software em si consome muita memória! Se o software InDesign tiver dificuldades com arquivos de até 5 MB, talvez seja prudente verificar outros processos em andamento (software antivírus, por exemplo, em execução intermitente).
Perguntas: Como posso saber quando foi a última vez que exportei conteúdo para minha equipe de design?
Resposta: Recomendamos aqui que você crie um marco na plataforma Workiva toda vez que exportar para o InDesign. Você pode então criar uma linha preta entre cada marco.
Pergunta: Há alguma limitação na plataforma Workiva com relação ao tamanho do ICML a ser exportado, ou do IDML a ser importado, ou dos arquivos XHTML/PDF finais a serem publicados?
Resposta: Reguladores diferentes têm limites de tamanho de arquivo diferentes, portanto, recomendamos verificar com antecedência. Para exportar para a plataforma Workiva a partir do software InDesign e vice-versa, atualmente há um limite de tempo limite de 2 minutos. Os arquivos precisam ser carregados dentro desse prazo.





IDML
Pergunta: É possível ver o XHTML sem as tags iXBRL?
Resposta: Sim, é possível ver apenas o XHTML. Se as opções autônomas não aparecerem na conta, entre em contato com o CSM para ativar essa opção. Você não vê o estilo da tabela no Workiva. Ele faz parte da exportação do ICML.
Pergunta: Com relação à importação do InDesign para o Workiva, nosso relatório anual tem 4 colunas, que são tratadas pelo nosso designer devido à sua complexidade. Como isso funcionará?
Resposta: Quando importamos um arquivo IDML do InDesign para a Workiva, não importamos o conteúdo para a plataforma em si. Convertemos IDML em XHTML, que
pode ser baixado e visualizado em seu navegador. A conversão será a mais próxima possível do layout do InDesign, desde que as diretrizes sejam seguidas. As colunas no InDesign são compostas por uma única história que flui através delas. Essas colunas estão conectadas. Para converter com precisão, você precisa usar o recurso de quadro dividido incorporado ao InDesign.

Questão: Carreguei meu arquivo IDML no Workiva, mas só consigo fazer o download do XHTML. Não consigo visualizá-lo no IXBRL Viewer. Por que isso acontece?
Resposta: Você precisa voltar ao seu cliente e solicitar permissão para acessar o XBRL. Nem todos os usuários têm acesso a todas as áreas.
Perguntas: A exportação de IDML do InDesign alterará o conteúdo no Workiva?
Resposta: Um arquivo IDML importado para a plataforma NÃO alterará o conteúdo. Ele é convertido imediatamente em XHTML, onde você pode abri-lo em seu navegador. Esse arquivo não pode ser editado. Ele teria que ser editado no Workiva e, em seguida, ser transferido para o InDesign e reexportado.
Pergunta: Meu documento falha na conversão!
Resposta:
· Além de todos os comentários anteriores, verifique cuidadosamente as diretrizes.
· Certifique-se de que todo o ICML esteja desvinculado.
· Todas as alterações de trilha são confirmadas.
· Todos os quadros de texto são divididos.
· Todos os itens não estão agrupados.
· Nenhum plug-in de terceiros está ativo ou afeta nossos processos.
· 
Os estilos são nomeados corretamente. Por exemplo, vimos um arquivo que tinha um # no final de um nome de estilo. Isso
corrompeu o próprio arquivo do InDesign. Observe também se há um espaço no final de um nome de estilo.
· Verifique se há ativos de imagem não compatíveis com a Web.
· Verifique se há fontes corrompidas.
· Certifique-se também de que seu IDML não esteja corrompido. Tente abri-lo novamente no InDesign e, em seguida, reexportar para IDML a partir do próprio documento.
· Se você estiver protegido por um firewall muito rígido, verifique se isso não está causando problemas.
· Tente sua conversão em outro momento. Pode ser apenas um caso de tráfego de rede.
· Se você tiver formas complexas no InDesign em várias páginas, talvez valha a pena convertê-las em SVG para simplificar a conversão.
· Lembre-se de desvincular o ICML antes de dividir os quadros de texto.
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Todas as informações, conteúdo e materiais disponíveis neste documento são apenas para fins de informação geral. O conteúdo desta postagem é fornecido "no estado em que se encontra"; não é feita nenhuma declaração de que o conteúdo esteja livre de erros ou atualizado. Os designers devem testar seu design em XHTML com frequência e manter arquivos de backup o tempo todo.

















Adobe, Illustrator, InDesign e Photoshop são marcas registradas ou marcas comerciais da Adobe nos Estados Unidos e/ou em outros países. Microsoft e Word são marcas registradas do grupo de empresas Microsoft. XBRL® e iXBRL™ são marcas registradas da XBRL International, Inc. Todos os direitos reservados. Os padrões XBRL™/® são abertos e licenciados gratuitamente por meio do XBRL International License Agreement. Nosso uso dessas marcas registradas é permitido pela XBRL International de acordo com a Política de Marcas Registradas da XBRL International.
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Informações Confidenciais e Proprietárias da Workiva


 Contatos de suporte
Em caso de dúvidas, entre em contato com seu gerente de Sucesso do Cliente ou com nossa Equipe de Suporte.
helpdesk 24 horas por dia, 7 dias por semana
Reino Unido - +44 8000885141 França - +33 801840098 EUA - 1-877-934-8435 Da Europa: 00-800-5005-0080 Dos EUA: 1-800-706-6526
Uma lista completa dos nossos números de telefone de suporte global pode ser encontrada aqui Ou envie um e-mail para a nossa equipe de suporte diretamente pelo endereço support@workiva.com
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A Workiva Inc. (NYSE: WK) simplifica o trabalho complexo de milhares de organizações em todo o mundo. Os clientes confiam na plataforma aberta, inteligente e intuitiva da Workiva para conectar dados, documentos e equipes. Os resultados: maior eficiência, maior transparência e menos riscos.
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